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Graphical Field Display

NOTICE

Read this manual before working with the product. For personal and system safety, and for
optimum product performance, make sure you thoroughly understand the contents before
installing, using, or maintaining this product.

For equipment service or support needs, contact your local Emerson Process
Management/Rosemount Tank Gauging representative.

Spare Parts

Any substitution of non-recognized spare parts may jeopardize safety. Repair, e.g.
substitution of components etc, may also jeopardize safety and is under no circumstances
allowed.

Rosemount Tank Radar AB will not take any responsibility for faults, accidents, etc caused
by non-recognized spare parts or any repair which is not made by
Rosemount Tank Radar AB.

Cover Photo: 2230_coverphoto_2.jpog
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1.1 SAFETY
MESSAGES

ROSEMOUNT

Tank Gauging

Procedures and instructions in this manual may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A ). Refer to
the safety messages listed at the beginning of each section before performing
an operation preceded by this symbol.

Failure to follow these installation guidelines could result in death or serious
injury:
» Make sure only qualified personnel perform the installation.

+ Use the equipment only as specified in this manual. Failure to do so may
impair the protection provided by the equipment.

Explosions could result in death or serious injury:

+ Verify that the operating environment of the transmitter is consistent with the
appropriate hazardous locations certifications.

» Before connecting a hand held communicator in an explosive atmosphere,
make sure the instruments in the loop are installed in accordance with
intrinsically safe or non-incendive field wiring practices.

* Do not remove the cover in explosive atmospheres when the circuit is alive.
+ Substitution of components may impair Intrinsic Safety.

+ To prevent ignition of flammable or combustible atmospheres, disconnect
power before servicing.

Electrical shock could cause death or serious injury.

+ Use extreme caution when making contact with the leads and terminals.

AWARNING

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution
of components etc., may also jeopardize safety and is under no circumstances allowed.

EMERSON.

www.rosemount-tg.com
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1.2 SYMBOLS
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APPROVED
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1-2

The CE marking symbolizes the conformity
of the product with the applicable European
Community Directives.

The EC-Type Examination Certificate is a
statement of a Notified Certification Body
declaring that this product meets the
Essential Health and Safety Requirements
of the ATEX directive.

The FM APPROVED Mark indicates that the
equipment is approved by FM Approvals
according to applicable Approval Standards
and is applicable for installation in
hazardous locations.

Protective Earth.

Ground.

External cabling must be approved for use in
min. 75°C.

Section 1. Introduction
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1.3 MANUAL Section 1:Introduction
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» System Overview
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* Installation Procedure
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* Mounting considerations
* Mechanical installation
* Electrical installation
* LED signals and Reset button
+ Switches
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* Menu tree
+ Select View menu
*  Options menu
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Section 5: Service and troubleshooting
+ Service
» Troubleshooting
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» Specifications
* Dimensional Drawings
* Ordering Information
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1.4 TECHNICAL

1-4

DOCUMENTATION

The Raptor System includes the following documents:

Raptor Technical Description (704010EN)

Rosemount 5900S Reference Manual (300520EN)

Rosemount 2410 Reference Manual (300530EN)

Rosemount 2240S Reference Manual (300550EN)

Rosemount 2230 Reference Manual (300560EN)

Raptor System Configuration Manual (300510EN)

Rosemount 5300 Product Data Sheet (00813-0100-4530)
Rosemount 5400 Product Data Sheet (00813-0100-4026)
Rosemount 5300 Series Reference Manual (00809-0100-4530)
Rosemount 5400 Series Reference Manual (00809-0100-4026)
Rosemount TankMaster WinOpi Reference Manual (303028EN)
Rosemount Raptor Installation Drawings

Section 1. Introduction
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1.5 PRODUCT Recycling of equipment and packaging should be taken into consideration
RECYCLING/ and disposed of in accordance with local and national legislation/regulations.
DISPOSAL The label below is put on Rosemount Tank Gauging products as a

Figure 1-1. A green label is
placed on the housing of the
level gauge

1.6 PACKING
MATERIAL

1.6.1 Reuse and
Recycling

1.6.2 Energy recovery

Section 1. Introduction

recommendation to customers if scrapping is considered.

Recycling or disposal should be done following instructions for correct
separation of materials when breaking up the units.

Rosemount Tank Radar AB is fully certified according to ISO 14001
environmental standards. By recycling the corrugated paperboard, or wooden
boxes, used for shipping our products you can contribute to take care of the
environment.

Experience has shown that wooden boxes can be used several times for
various purposes. After careful disassembly the wooden parts may be reused.
Metal waste may be converted.

Products which have served their time may be divided into wood and metal
components and the wood can be used as fuel in sufficient ovens.

Due to its low moisture content (approximately 7%) this fuel has a higher
calorific value than ordinary wood fuel (moisture content approximately 20%).

When burning interior plywood the nitrogen in the adhesives may increase
emissions of nitrogen oxides to the air 3-4 times more than when burning bark
and splinter.

NOTE!
Landfill is not a recycling option and should be avoided.

1-5
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Section 2 Overview

21 Introduction.............. ... i, page 2-1
22 2230Components . ............iiiiiiaiaaannn page 2-2
2.3 SystemOverview ............. ... page 2-3
2.4 Installation procedure ....................... page 2-8
2.1 INTRODUCTION The Rosemount 2230 Graphical Field Display presents inventory tank

gauging data such as level, temperature, and pressure. The 2230
communicates with the Rosemount 2410 Tank Hub via the intrinsically safe
2-wire Tankbus(".

A 2230 connected to the multiple tank version of the 2410 allows you to view
data from several tanks. It is possible to configure presentation of
measurement variables for each tank individually.

The four softkeys at the front of the 2230 allow you to navigate through the
different menus and provides all tank data, directly on the field.

Data from a group of tanks is buffered by a 2160 Field Communication Unit
(FCU), and is distributed via the Group Bus to a TankMaster PC, or a host
system, whenever the FCU receives a request for data. In case no FCU is
included in the system, the 2410 Tank Hub can communicate directly with the
host computer.

Figure 2-1. System integration

5900S Radar  2240S Temperature
Level Gauge Transmitter

— | TankMaster

2160 Field
Communication Unit

2410 Tank Hub
I

=]

T4

' 2230 Display

Primary Bus

Secondary bus Tankbus

Relay outputs

(1) The intrinsically safe Tankbus complies with the FISCO FOUNDATION™ fieldbus standard.
See reference document IEC/TS 60079-27.

ROSEMOUNT s
Tank Gauging EMERSON.

www.rosemount-tg.com
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2.2 2230 COMPONENTS

Figure 2-2. Rosemount 2230
components

Product temperature
26.7°C

Tank-5 3]
2 \S/j Level
/ 2412m

© ©

Weather protection lid™"
Display

Menu

Soft keys

Activity indicator

Cover screw

Cable entries: two M20 x 1.5 and one M25 x 1.5
(optional: %2 - 14 NPT and % - 14 NPT adapters)

Ground screw

N ok~ owdh-=

®

9. Locking spring for weather protection

(1) Itis recommended that the lid is closed whenever possible to protect the LCD from exposure
by ultraviolet radiation from the sun.
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2.3 SYSTEM
OVERVIEW

Section 2. Overview

Raptor is a state-of-the art inventory and custody transfer radar tank level
gauging system. It is developed for a wide range of applications at refineries,
tank farms and fuel depots, and fulfills the highest requirements on
performance and safety.

The field devices on the tank communicate over the intrinsically safe Tankbus.
The Tankbus is based on a standardized fieldbus, the FISCO" FOUNDATION™
fieldbus, and allows integration of any device supporting that protocol. By
utilizing a bus powered 2-wire intrinsically safe fieldbus the power
consumption is minimized. The standardized fieldbus also enables integration
of other vendors’ equipment on the tank.

The Raptor product portfolio includes a wide range of components to build
small or large customized tank gauging systems. The system includes various
devices, such as radar level gauges, temperature transmitters, and pressure
transmitters for complete inventory control. Such systems are easily
expanded thanks to the modular design.

Raptor is a versatile system that is compatible with and can emulate all major
tank gauging systems. Moreover, the well-proven emulation capability
enables step-by-step modernization of a tank farm, from level gauges to
control room solutions.

It is possible to replace old mechanical or servo gauges with modern Raptor
gauges, without replacing the control system or field cabling. It is further
possible to replace old HMI/SCADA-systems and field communication
devices without replacing the old gauges.

There is a distributed intelligence in the various system units which
continuously collect and process measurement data and status information.
When a request for information is received an immediate response is sent
with updated information.

The flexible Raptor system supports several combinations to achieve
redundancy, from control room to the different field devices. Redundant
network configuration can be achieved at all levels by doubling each unit and
using multiple control room work stations.

(1) See documents IEC 61158-2 and IEC/TS 60079-27
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Figure 2-3. Raptor system

architecture

CUSTODY TRANSFER / INVENTORY TANK GAUGING

OPERATIONAL CONTROL

2-4

2180 Field
Bus Modem

NON-HAZARDOUS AREA ] HAZARDOUS AREA

TankMaster PC

W1

2160 Field
Communication Unit

5900S Radar  2240S Temperature
Level Gauge Transmitter

’ 2230 Display %%
2410 Tank Hub %

| | 3051S
SEE====——us Pressure
Wl Transmitter

= \
’ Tankbus T
’ [ X6)

’ 5900S Radar
Level Gauge

Plant Host Computer

2410 Tank Hub
<

=)
E=0)

= )+ 644Temperature
Transmitter

2240S Temperature
Transmitter

5400 Level
Transmitter

Tankbus

5300 Level
’ Transmitter
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Section 2. Overview

TankMaster HMI Software

TankMaster is a powerful Windows-based Human Machine Interface (HMI) for
complete tank inventory management. It provides configuration, service,
set-up, inventory, and custody transfer functions for Raptor systems and other
supported instruments.

TankMaster is designed to be used in the Microsoft Windows XP and Vista
environment providing easy access to measurement data from your Local
Area Network.

The TankMaster WinOpi program lets the operator monitor measured tank
data. It includes alarm handling, batch reports, automatic report handling,
historical data sampling as well as inventory calculations such as Volume,
Observed Density and other parameters. A plant host computer can be
connected for further processing of data.

The TankMaster WinSetup program is a graphical user interface for
installation, configuration and service of the different devices in the Raptor
system.

Rosemount 2160 Field Communication Unit

The 2160 Field Communication Unit (FCU) is a data concentrator that
continuously polls and stores data from field devices such as radar level
gauges and temperature transmitters in a buffer memory. Whenever a request
for data is received, the FCU can immediately send data from a group of tanks
from the updated buffer memory.

Rosemount 2410 Tank Hub

The Rosemount 2410 Tank Hub acts as a power supply to the connected field
devices in the hazardous area using the intrinsically safe Tankbus.

The 2410 collects measurement data and status information from field
devices on a tank. It has two external buses for communication with various
host systems. There are two versions of the 2410 for single tank or multiple
tanks operation. The multiple tanks version supports up to 10 tanks and 16
devices.

The 2410 is equipped with two relays which support configuration of up to 10
“virtual” relay functions allowing you to specify several source signals for each
relay.

Rosemount 5900S Radar Level Gauge

The Rosemount 5900S Radar Level Gauge is an intelligent instrument for
measuring the product level inside a tank. Different antennas can be used in
order to meet the requirements of different applications. The 5900S can
measure the level of almost any product, including bitumen, crude oil, refined
products, aggressive chemicals, LPG and LNG.

The Rosemount 5900S sends microwaves towards the surface of the product
in the tank. The level is calculated based on the echo from the surface. No
part of the 59008 is in actual contact with the product in the tank, and the
antenna is the only part of the gauge that is exposed to the tank atmosphere.

The 2-in-1 version of the 5900S Radar Level Gauge has two radar modules in
the same transmitter housing allowing two independent level measurements
using one antenna.

2-5
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Rosemount 5300 Guided Wave Radar

The Rosemount 5300 is a premium 2-wire guided wave radar for level
measurements on liquids, to be used in a wide range of medium accuracy
applications under various tank conditions. Rosemount 5300 includes the
5301 for liquid level measurements and the 5302 for liquid level and interface
measurements.

Rosemount 5400 Radar Level Transmitter

The Rosemount 5400 is a reliable 2-wire non-contact radar level transmitter
for liquids, to be used in a wide range of medium accuracy applications under
various tank conditions.

Rosemount 2240S Multi-Input Temperature Transmitter

The Rosemount 2240S Multi-input Temperature Transmitter can connect up
to 16 temperature spot sensors and an integrated water level sensor.

Rosemount 2230 Graphical Field Display

The Rosemount 2230 Graphical Field Display presents inventory tank
gauging data such as level, temperature, and pressure. The four softkeys
allow you to navigate through the different menus to provide all tank data,
directly in the field. The Rosemount 2230 supports up to 10 tanks. Up to three
2230 displays can be used on the Tankbus.

Rosemount 644 Temperature Transmitter

The Rosemount 644 is used with single spot temperature sensors.

Rosemount 3051S Pressure Transmitter

The 3051S series consists of transmitters and flanges suitable for all kinds of
applications, including crude oil tanks, pressurized tanks and tanks with /
without floating roofs.

By using a 3051S Pressure Transmitter near the bottom of the tank as a
complement to a 5900S Radar Level Gauge, the density of the product can be
calculated and presented. One or more pressure transmitters with different
scalings can be used on the same tank to measure vapor and liquid pressure

Rosemount 2180 Field Bus Modem

The Rosemount 2180 field bus modem (FBM) is used for connecting a
TankMaster PC to the TRL2 communication bus. The 2180 is connected to
the PC using either the RS232 or the USB interface.

See the Raptor Technical Description (Document no. 704010en) for more
information on the various devices and options.

Section 2. Overview
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2.3.1 Raptor System The standard start-up procedure of a Raptor system that includes devices
Start-up such as the 2160 Field Communication Unit, 2410 Tank Hub, 5900S Radar

Level Gauge, and the 2240S Multi-input Temperature Transmitter can be
summarized in the following brief description:

1. Install the devices on the appropriate locations.

2. Assign Modbus addresses!") for the Rosemount 2410 Tank Hub, level
gauges such as the 5900S Radar Level Gauge, and auxiliary tank
devices (ATD) such as the 2240S Multi-input Temperature Transmitter.
The Modbus addresses will be stored in the built-in databases of the
Rosemount 2410 Tank Hub and the Rosemount 2160 Field
Communication Unit.

3. Verify that the total current consumption of devices connected to the
Tankbus does not exceed 250 mA®).

4. Wire the devices.

» Connect field devices to the Tankbus.
Note! Devices must be configured in the tank databaseM of the
Rosemount 2410 Tank Hub in order to be able to communicate on the
Tankbus.

¢ Connect the Rosemount 2410 Tank Hub to the Rosemount 2160 Field
Communication Unit.

+ Connect the Rosemount 2160 Field Communication Unit to the control
room PC with TankMaster software. The 2160 may be connected via a
Rosemount 2180 Field Bus Modem, or directly via RS 232 or RS 485.

5. Install the TankMaster software in the control room PC.

6. Configure the Raptor devices by using the TankMaster WinSetup
configuration tool as described in the Rosemount Raptor System
Configuration Manual (Document no. 300510EN).

See the reference manuals for other devices in the Raptor system for further
information on installation and configuration.

(1) See the Rosemount Raptor System Configuration Manual (Document no. 300510EN) for
more information

(2) See the Rosemount 2410 Tank Hub Reference Manual, Document No. 300530EN for more
information

Section 2. Overview 2-7
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INSTALLATION
PROCEDURE

Follow these steps for proper installation of the Rosemount 2230 Graphical

Field Display:

1. Review installation considerations
(“Installation Considerations” on page 3-2)

'

2. Mount the 2230 in a suitable location
(“Mounting the Graphical Display” on

page 3-3)
3. Wire the 2230

(“Electrical Installation” on page 3-6)

'

4. Power up the 2230

'

5. Configure the 2230
(Section 4: Configuration and Operation)

Section 2. Overview
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31 SafetyMessages ..............cciiiinnnnt. page 3-1

3.2 Mechanical Installation ...................... page 3-2

3.3 Electrical Installation ........................ page 3-6

3.4 LED signals and ResetButton ................ page 3-13

35 Switches ............ i e page 3-14

3.6 AmbientTemperature ........................ page 3-14

3.1 SAFETY
MESSAGES

ROSEMOUNT

Tank Gauging

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A ). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

AWARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

Substitution of components may impair Intrinsic Safety.

To prevent ignition of flammable or combustible atmospheres, disconnect power before
servicing.

AWARNING

Explosions could result in death or serious injury:

Verify that the operating environment of the display is consistent with the appropriate
hazardous locations certifications.

Before connecting a hand held communicator in an explosive atmosphere, make sure
the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

AWARNING

High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals.

Make sure the main power to the Tank Hub is off and the lines to any other external
power source are disconnected or not powered while wiring the device.

&

EMERSON.

www.rosemount-tg.com
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3.2 MECHANICAL
INSTALLATION

3.2.1 Installation
Considerations

Figure 3-1. Space required for
opening the lid

3-2

The Rosemount 2230 Graphical Field Display can be installed either on the
tank roof or at the foot of the tank for a flexible and convenient read-out of
tank data.

The 2230 is designed for mounting on a plate, on a wall, or on a pipe. The
display is attached to the plate with four M4 screws. It is important to provide
space for opening the weather protection lid which prevents degradation of
the LCD display due to sunlight exposure.

Consider the following when finding an appropriate location for the
Rosemount 2230 Graphical Field Display:

Mount the 2230 in a location where it is protected from excessive sun
light. This will reduce exposure to ultra violet (UV) radiation and extend
the life-time of the LCD.

In case the 2230 can not be protected from sun light and UV radiation,
it is recommended that the weather protection lid (see “2230
Components” on page 2-2) is closed whenever the 2230 is not used.

An optional weather protection is available as an alternative method to
protect the 2230.

When mounting the 2230 display ensure that sufficient space is
provided for opening the lid, see Figure 3-1.

\47 Weather protection

(optional)

Section 3. Installation
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3.2.2 Mounting the
Graphical Display

Figure 3-2. Mounting hole
pattern

Section 3. Installation

The Rosemount 2230 Graphical Field Display is designed for mounting on a
plate, wall, or pipe.

Mounting on a Plate
The 2230 display can be mounted on a plate by attaching four M4 screws to
the back of the display. To mount the 2230:
1. Drill four holes in the plate according to the hole pattern on the back of
the 2230 display as illustrated in Figure 3-2.

2. Mount the 2230 on the plate using four M4 screws. Note that the M4
screws that are shipped with the 2230 display can be used as long as the
plate thickness does not exceed 5 mm (0.2 in.).

60 mm (2.4 in.)

89
68 mm (2.7 in.)

3-3
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Wall Mounting with Bracket

The Rosemount 2230 Graphical Field Display can be mounted on a wall by
using the optional mounting kit supplied by Rosemount Tank Gauging.

! 70 mm ! 29 mm
O —©
3 O -

©
@)

94 mm

1. Mount the bracket on the wall by using
four M8 screws and flat washers.
Note! Countersunk screws are not
suitable.

Mounting plate

2. Attach the mounting plate to the back of
the 2230 housing.

3. Attach the 2230 display to the bracket
on the wall and tighten the locking
screw.

34
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Pipe Mounting

The 2230 can be mounted on pipes ranging from diameter 33 to 60 mm by
using an optional mounting kit supplied by Rosemount Tank Gauging.

1. Attach the bracket to the pipe.

2. Ensure that the 2230 is placed in a
direction so that the display is clearly
visible and wiring can be properly
connected.

4 nuts and

3. Tighten the nuts. Use moderate torque
to ensure that the bracket does not

Bracket ———» break.

4. Attach the mounting plate to the back of
the 2230 housing.

5. Attach the 2230 to the bracket by sliding
it from the top downwards.

Bracket

Mounting plate

6. Secure the 2230 to the bracket by
tightening the locking screw.

Section 3. Installation 35
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3.3 ELECTRICAL
INSTALLATION

3.3.1 Cable/Conduit
Entries

3.3.2 Grounding

The electronics housing has three entries, two M20x1.5 and one M25x1.5
(Optional: adapters for two %2 - 14 NPT and one %- NPT). Minifast and
eurofast adapters are also available. The connections are made in
accordance with local or plant electrical codes.

Make sure that unused ports are properly sealed to prevent moisture or other
contamination from entering the electronics housing.

NOTE!
Use a enclosed metal plug to seal the unused entry/entries. The plastic plugs
mounted at delivery are not sufficient as seal!

The housing should always be grounded in accordance with national and
local electrical codes. Failure to do so may impair the protection provided by
the equipment. The most effective grounding method is direct connection to
earth ground with minimal impedance.

There is an external grounding screw located at the bottom of the housing,
see Figure 3-3, and an internal grounding screw located inside the housing,
see Figure 3-5.

The internal ground screw is identified by a ground symbol: @

Figure 3-3. Grounding screws

T O —@
A &l

E R\

MaO—60—Ow4

T

3-6

. :
e

External ground
Cable diameter
minimum 4 mm?

Internal ground

NOTE!
When grounding the display via threaded conduit, make sure the connection
provides sufficient low impedance.
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3.3.3 Cable Selection
for the Tankbus

Table 3-1. FISCO cable
parameters

3.3.4 Hazardous Areas

3.3.5 Power
Requirements

Section 3. Installation

Grounding - FOUNDATION™ Fieldbus

Signal wiring of the fieldbus segment must not be grounded. Grounding one
of the signal wires will shut down the entire fieldbus segment.

Shield Wire Connection

To protect the fieldbus segment from noise, grounding techniques for shield
wire usually require a single grounding point for shield wire to avoid creating a
ground loop. The ground point is typically at the power supply (Rosemount
2410 Tank Hub).

The Raptor devices are designed for “daisy-chain” connection of shield wiring
in order to enable a continuous shield throughout the Tankbus network. The
shield wire terminal in the 2230 is not connected to ground. It only provides
electrical continuity to daisy-chained Tankbus cables.

Use shielded twisted pair wiring for the Rosemount 2230 in order to comply
with FISCO" requirements and EMC regulations. The cables must be
approved for use in hazardous areas, where applicable. In the U.S.
explosion-proof conduits may be used in the vicinity of the vessel.

We recommend cable size 0.75 mm? (18 AWG) in order to facilitate wiring.
However, cables within the range 22 AWG to 16 AWG (0.5t 01.5 mm?) in
order to minimize the voltage drop to the 2230 display.

Tankbus cabling must be approved for use in minimum 85°C to match
requirements for all devices in a Raptor system.

The FISCO specification requires that cables for the Tankbus comply with the
following parameters:

Parameter Value

Loop resistance

15Q/km to 150Q/km

Loop inductance

0.4 mH/km to 1 mH/km

Capacitance

45 nF/km to 200 nF/km

Maximum length of each spur cable

60 m in apparatus class IIC and IIB

Maximum length of each trunk cable

1000 m in apparatus class IIC and 1900 m in
apparatus class 1B

When the Rosemount 2230 is installed in a hazardous area, national and
local regulations and specifications in applicable certificates must be
observed, see Appendix B: Product Certifications.

The Rosemount 2230 is powered over the intrinsically safe Tankbus by the
Rosemount 2410 Tank Hub. The 2410 feeds the intrinsically safe fieldbus
segment by acting as a FISCO power supply on the Tankbus (9 - 17.5 Vdc,

polarity insensitive).

See the Rosemount 2410 Reference Manual (Document no. 305030EN) for

more information.

(1) See IEC 61158-2 and IEC/TS 60079-27:2002.
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3.3.6 The Tankbus

3-8

The Raptor system is easy to install and wire. Devices can be “daisy-chained”
thus reducing the number of segment couplers.

In a Raptor system devices communicate with a Rosemount 2410 Tank Hub
via the intrinsically safe Tankbus. The Tankbus complies with the FISCO(")
FOUNDATION fieldbus standard. The Rosemount 2410 acts as power supply to
the field devices on the Tankbus.

Termination

A terminator is needed at each end of a FOUNDATION Fieldbus network.
Generally, one terminator is placed in the fieldbus power supply, and the other
one in the last device in the fieldbus network.

NOTE!
Ensure that there are two terminators on the fieldbus.

In a Raptor system the Rosemount 2410 Tank Hub acts as power supply.
Since the 2410 normally is the first device in the fieldbus segment, the built-in
termination is enabled at factory.

Other Raptor devices such as the Rosemount 5900S Radar Level Gauge, the
Rosemount 2230 Graphical Field Display, and the Rosemount 2240S
Multi-input Temperature Transmitter also have built-in terminators which can
easily be enabled by inserting a jumper in the terminal block when necessary.

Segment design

When designing a FISCO fieldbus segment a few requirements need to be
considered. Cabling has to comply with FISCO requirements as described in
“Cable Selection for the Tankbus” on page 3-7.

You will also have to ensure that the total operating current of the connected
field devices is within the output capability of the Rosemount 2410 Tank Hub.
The 2410 is able to deliver 250 mA. Consequently, the number of field devices
has to be considered so that the total current consumption is less than

250 mA.

Another requirement is to ensure that all field devices have at least 9 V input
voltage at their terminals. Therefore you will have to take into account the
voltage drop in the fieldbus cables.

Distances are normally quite short between the Rosemount 2410 Tank Hub
and field devices on the tank. In many cases you can use existing cables as
long as the FISCO requirements are fulfilled (see “Cable Selection for the
Tankbus” on page 3-7).

See "The Tankbus” in the Rosemount 2410 Reference Manual (Document no.
305030EN) for more information on segment design of a Raptor system.

(1) FISCO=Fieldbus Intrinsically Safe Concept
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3.3.7 Typical
installations

Figure 3-4. Example of Tankbus
connection for a single tank

2410 Tank Hub with
intrinsically safe power

supply, integrated power

conditioner, and built-in
terminator

Section 3. Installation

The example below in Figure 3-4 illustrates a Raptor system with terminators
at both ends of the fieldbus segment as required in a FOUNDATION fieldbus
system. In this case terminators are enabled in the Rosemount 2410 Tank
Hub and a Raptor field device at the end of the network segment.

Tankbus length up to 1000 meter depending
on number of devices and cable quality

- —

~§— Built-in terminator

2230 Display 2240S Temperature

Transmitter
5900S Radar

Level Gauge

Built-in
/ 2 terminator
e enabled on the
Tankbus ) g.; last device

Naiod &

The maximum distance between the 2410 Tank Hub and the field devices on
the tank depends on the number of devices connected to the Tankbus and the
quality of cables.

See chapter “Electrical Installation” in the Rosemount 2410 Reference
Manual (Document no. 305030EN) for more information about cable
selection, power budget, and the Raptor Tankbus.

See also “Typical Installations” in the Rosemount 2410 Reference Manual
(Document no. 305030EN) for more examples of Raptor system installations.
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3.3.8 Wiring

3-10

Use the following wiring procedure for the Rosemount 2230:

1. Unscrew and remove all six screws at the front of the display.

2. Remove the cover carefully. Take care of the locking spring for the
weather protection hatch, see “2230 Components” on page 2-2.

NOTE!
Do not disconnect the cables between the display front and the circuit board.
Ensure that the compartment is protected against water in case of rain.

3. Run the Tankbus cable through the gland.

4. Connect the Tankbus wires to the X2 and X3 terminals as illustrated in
Figure 3-5 on page 3-11. Ensure that the positive lead is connected to
the terminal marked FB+ and the negative lead to the terminal marked
FB-.

5. Connect the cable shield to the “Shield Loop Through” (X1) terminal.

6. If the 2230 display is the last device on the Tankbus, connect a jumper
for the built-in termination. See “The Tankbus” on page 3-8 for more
information on termination.

7. Replace the cover. Make sure that the sealing and the locking device for
the weather protection hatch are placed in the correct positions.

8. Firmly tighten the six screws on the front cover.

NOTE!

Ensure that o-rings and seats are in good condition prior to mounting the
cover in order to maintain the specified level of ingress protection. The same
requirements apply for cable inlets and outlets (or plugs). Cables must be
properly attached to the cable glands.
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Figure 3-5. 2230 cable
connections
X2: Tankbus (+) output
------------------- Daisy-chain
c_onnecti_on to other
| X3 Tankbus () output (0 CaeRs

Sealing

Front cover j

Jumper for
built-in
termination

-~

Cable Shield X4: Tankbus

terminator

J/©

Internal grounding L

X2: Tankbus FB+ input

X3: Tankbus FB- input
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Daisy-Chain Connection

You may use the daisy-chain option in order to connect the Rosemount 2230
to other field devices on the Raptor Tankbus:

1. Unscrew and remove all six screws on the front of the Rosemount 2230.
Remove the cover carefully. Take care of the locking device for the
weather protection hatch.

NOTE!
Do not disconnect the cables between the display front and the circuit board.

2. Disconnect the termination jumper from the X3 terminal, see Figure 3-5
on page 3-11.

3. Run the new Tankbus cable into the 2230 compartment through a
suitable gland.

4. Connect the outgoing Tankbus wires to the X2-out and X3-out terminals
as shown in Figure 3-6.

Figure 3-6. Daisy-chain wiring
X2: out

X3: out

X1: Cable Shield ;

5. Connect the cable shield to the X1 terminal.

6. Replace the cover. Make sure the sealing and the locking device for the
weather protection hatch are placed in the correct positions.

7. Firmly tighten the six screws on the front cover.

Figure 3-7. Wiring diagram for As illustrated in Figure 3-7 the Rosemount 2230 can be daisy-chained to
Rosemount 2230 other field devices via the Tankbus.
Rosemount 2410 Rosemount 2230 Rosemount 5900S Rosemount 2240S
Shield Wire Built-in
connected at terminator
enabled on

power supply
the last device

Tankbus
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3.4 LED SIGNALS AND
RESET BUTTON

Figure 3-8. LED Signals

Section 3. Installation

The Rosemount 2230 has three LED signals that show communication and
status.

Reset button Status LED

Tankbus Transmit Tankbus Receive I T
(green) (yellow)

Status LED

Using different blinking sequences, the status LED indicates error codes. In
normal operation the LED flashes every other second. When an error occurs,
the LED flashes a sequence that corresponds to a code number followed by a
five second pause. This sequence is continuously repeated (for more
information see “Device Error Signals” on page 5-6).

Communication LED:s

Tankbus communication is indicated by a pair of LED:s, see Figure 3-8. When
you connect the Tankbus cables you can check the communication status
with the LED:s.

Reset Button

You may use the Reset button to force a restart of the Rosemount 2230
display. Restarting the 2230 has the same effect as switching off and on the
power supply.

The Restart option will connect the Rosemount 2230 display to the
Rosemount 2410 Tank Hub and perform start-up tests of software and
hardware.
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3.5 SWITCHES

3.5.1 DIP Switches The Rosemount 2230 is equipped with four DIP switches as illustrated in
Figure 3-9.

Figure 3-9. DIP Switches

©
1 [ o
2| m D= ® o /
: HEEE
3 [ © |a ® ©
4
— @0 ©
© JIAN ©
t )
SO ©
II Il T LI I | 1 1 | T
The switches control the following settings:
Table 3-2. Rosemount 2230 DIP
Switches Number Name Description
1 Simulate Enables simulation for test of 2230 in open FF systems.
2 Write Protect Enables write protection of configuration data.
3 Spare Not used
4 Spare Not used
NOTE!

Manual configuration may override the switch setting.

The Simulate Switch

The Simulate switch is used to simulate measurement values from the tanks.
The switch returns from “ON” to “OFF” after power is applied. This feature
prevents the transmitter from being left in simulation mode.

Write Protect Switch
The Write Protect switch can be used to protect the Rosemount 2230 from
unintentional changes of the current configuration.

3.6 AMBIENT The Rosemount 2230 is equipped with a temperature sensor for measuring
TEMPERATURE ambient temperature. The temperature can be displayed on the field display
and in the TankMaster software.

3-14 Section 3. Installation



Reference Manual
300560EN, Rev AA
May 2011

Rosemount 2230

Section 4

4.1 SAFETY
MESSAGES

ROSEMOUNT

Tank Gauging

Configuration and Operation

41 SafetyMessages.............ciiiiiiinrnnnn. page 4-1
42 Introduction.............. ... i, page 4-2
43 MenuTree .......c.iiiiiiiiiiinninnnnennnns page 4-4
44 TheMainMenu .............. . i, page 4-5
45 The SelectViewMenu ....................... page 4-6
46 TheOptionsMenu ................ccievvunn.. page 4-7
47 TheServiceMenu ...................c..ou... page 4-14

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A ). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

Explosions could result in death or serious injury:

Verify that the operating environment of the display is consistent with the appropriate
hazardous locations certifications.

Before connecting a hand held communicator in an explosive atmosphere, make sure
the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

EMERSON.

www.rosemount-tg.com
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4.2 INTRODUCTION

421 The 2230
Graphical Field
Display

Figure 4-1. The
Rosemount 2230 display

4-2

This chapter provides information about configuration and operation of the
Rosemount 2230 Graphical Field Display.

For information on how to use TankMaster WinSetup to configure the 2230,
see the Raptor System Configuration Manual (Document no.300510EN).

The Rosemount 2230 is a graphical display designed for viewing tank data in
tough environments. It features adjustable LCD contrast, backlight,
multi-language support, and communication failure indication.

The four softkeys allow you to navigate through the different menus and to
select various functions for tank data viewing and service.

Menu: opens the Main Menu with various options for configuration of the
2230 display.

Pause: stops toggling the measurement variables until the Resume button is
pressed.

Down arrow: lets you scroll through the list of measurement variables and
tanks.

Status: lets you view the current status of the presented measurement
variable. See also “Status Information” on page 5-11.

A symbol in the upper right-hand corner of the display indicates that the 2230
is operating and communicates on the Tankbus.

——————

Note! It is recommended that
the lid is closed whenever

| possible to protect the LCD
from exposure by ultraviolet
radiation from the sun

Weather protection lid

Activity indicator

. © Level ©
Display 2412m
Product temperature
26.7°C
Softkey functions [MenuTPause] ¥ TStatus]
sotrs ‘0000
© © ©

The Rosemount 2230 is powered by the Tankbus (see “Power Requirements”
on page 3-7).

Adjusting the display contrast

The 2230 automatically adjusts display contrast to optimize for changes of
ambient temperature. The contrast can be manually adjusted when further
fine-tuning is desired. To increase the display contrast, press the two buttons
on the right-hand side simultaneously. To decrease the contrast, press the two
buttons on the left-hand side. It takes approximately 10 seconds to adjust
from minimum to maximum contrast.

The contrast can also be adjusted by using the Contrast service command:
<Menu><Service><LCD Contrast>.
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4.2.2 Activity and
Alarm Indication

Figure 4-2. Simulated or manual
value

Figure 4-3. Invalid value

Figure 4-4. Activity indicator

The Rosemount 2230 display shows a warning symbol for simulated or
manual measurement values as illustrated in Figure 4-2 and Figure 4-3.

Manual or simulated measurement values are indicated by an alarm symbol
as shown in Figure 4-2.

Alarm symbol —»

Y

Tank-5 Q)
Level
2412 m
A Liquid temperature
26.7 °C
Menu [Pause] ¥ | Status

For invalid measurement data, the alarm symbol is displayed and no data
appears in the measurement value field as illustrated in Figure 4-3.

Invalid value

Tank-5 Q)
Level
2412 m
A Liquid temperature
P
Menu [Pause] ¥ |Status

The activity indicator spins continuously to indicate that the 2230 is operating
normally. In case of a communication problem an alarm symbol is displayed

instead.

Activity indicator for normal operation

'

Communication problems

Tank-5 0
Level
2412 m
Liquid temperature
26.7 °C i
Menu [Pause| ¥ |Status
Tank-5 A
A Level
ALiquid temperature
Menu [Pause] ¥ [Status

Section 4. Configuration and Operation
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4.3 MENU TREE

The Rosemount 2230 lets you navigate in a menu structure as illustrated in

Figure 4-5:
Figure 4-5. Rosemount 2230
Menu Tree
Select View /Single Value
Options Two Values (2410 Tank Pos 1-10 )
Service Four Values 2410 Tk Pos 1
N 2410 Tk Pos 2
(2410 Tk Pos 3 )
Variables
4 N\
Tanks Default
Units for Display All
Toggle Time 2410 Tank Pos 1-10
Language
— | Length
Level rate
Flow rate
P < Volume
Status Temperature
Custody Transfer View Pressure
LCD Test Density
LCD Contrast
Restart
Factory Settings —{ Set Toggle Time J
About
& J
English
Spanish
French
Italian
German
Portuguese
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4.4 THE MAIN MENU In normal operation the Rosemount 2230 display is in View Mode and shows
the current measurement values for the selected tanks. In case of an alarm, a
graphical symbol appears on the screen.

Figure 4-6. Rosemount 2230
Graphical Field Display in View
Mode

Tank-5 O

@ Level @

2412m

Product temperature
26.7 °C

[ Menu [Pause] ¥ [Status]

softkey to
navigate to the
Main Menu

Press the Menu —. . . .
; ©

To navigate from View Mode to the Main Menu, press the Menu softkey on
the left-hand side.

Figure 4-7. The Main menu

Main Menu ©
Select View
Options »
Service »
ESC] 2 [ ¥ | »

The Main Menu includes the following options:

Select View which lets you select the preferred view, see section “The Select
View Menu” on page 4-6.

Options which lets you select variables and tanks to display, as well as
measurement units, toggle time, and language. See section “The Options
Menu” on page 4-7.

Service which includes the functions Status, Custody Transfer View, LCD
Test, Restart, and Factory Settings. It also includes the About option which
shows the current software version. See section “The Service Menu” on
page 4-14.
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4.5 THE SELECT VIEW In the Select View menu, you can specify the number of measurement values
MENU to be displayed in View Mode. To configure the Select View menu:

1. In View Mode, press the <Menu> button to navigate to the Main menu.

Figure 4-8. The Main menu
Main Menu ©
Select View
Options »
Service P
ESC]T * | ¥ | =»

2. Highlight the Select View menu item using the 4 and § softkeys.
3. Press the =p softkey.

Figure 4-9. The Select View
men Select View ©
Single value
Two values
Four values
ESC] ¢+ | ¥ [ OK

4. In the Select View Menu, use the up and down arrow softkeys to
navigate to the desired option.

5. Press the <OK> softkey to select the desired option. The Rosemount
2230 returns to View Mode.

For example, using the Two Values option will present a view as illustrated in

Figure 4-10:
Figure 4-10. Example of display
configuration with Two values
J Tank-5 O
Level
2412 m
Liquid temperature
26.7 °C
Menu [Pause| ¥ [Status
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4.6 THE OPTIONS
MENU

Figure 4-11. The Main menu

Figure 4-12. The Options menu

In the Options Menu, the following items are available:

Units for Display
Toggle Time

To choose an item in the Options menu:

1. In View Mode, press the <Menu> button to open the Main menu:

Main Menu )
Select View
Options »
Service P
Esc | *+ | ¥ | =

2. Highlight the Options menu item by using the 4 and § softkeys.
3. Press the =) softkey.

Options Menu

©

Variables

Tanks...

Units for Display...
Toggle time

Esc 1+ ¥

>

4. In the Options Menu, use the up and down arrow softkeys to navigate to

the desired menu item.

5. Press the & softkey to continue to the selected menu.

Section 4. Configuration and Operation
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4.6.1 Variables

Figure 4-13. The Select
Variables menu

Figure 4-14. The Select
Variables Custom option

4-8

In the Select Variables menu, you can choose which variables to present in
View Mode. The following options are available:

* 2410 Tank Pos 1-10 lets you configure a common set of variables to
be presented for all tanks

* 2410 Tk Pos 1, 2, 3... lets you configure variables individually for each
tank

For a list of available variables see Table 4-1 on page 4-9.

Select Variables Menu

The Select Variables menu allows you to select variables to be displayed in
View Mode. Option “2410 Tank Pos 1-10” can be used to specify a common
set of variables to be used for all tanks connected to the same 2410 Tank
Hub. In addition to this you can configure tanks individually by specifying a
unique set of variables for each tank. Note that the individual configuration will
be added to the configuration that is common for all tanks.

For a list of selectable variables, see Table 4-1 on page 4-9.
To select variables:

1. In View Mode, press <Menu> <Options> <Variables>.

Select Variables D)
2410 Tank Pos 1-10 ...
2410 Tk Pos 1 ...
2410 Tk Pos 2 ...
2410 Tk Pos 3 ...
Esc [ ¢ | ¥ | OK

2. Use the up and down arrow softkeys to navigate to the desired 2410
Tank Position item.

3. Press the <OK> softkey to continue to the Selected Variables list.

Select Variables D)
W Level
O Ullage
[ Level rate
O Signal strength
onofff ¢4 | ¥ | OK

4. In the Select Variables list, choose the variables you wish to show in
View Mode.

5. When finished, press <OK> to return to View Mode.
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Table 4-1. Selectable variables

Level Product level in the displayed tank.

Ullage Ullage is the distance from the Tank Reference
Point to the product surface.

Level Rate How the product in the tank moves when emptying
or filling the tank.

Signal Strength The signal strength of the radar level gauge.

Free Water Level The level of water in the bottom of the tank.
Available when a water level sensor is connected
to the tank.

Vapor Pressure Measured vapor pressure.

Liquid Pressure Measured liquid pressure.

Air Pressure Measured air pressure in the tank.

Ambient Temperature Air temperature outside the tank.

Vapor Temperature Temperature of vapor inside the tank.

Liquid Temperature Temperature of the product in the tank.

Tank Temperature Average temperature of the product in the tank

Temperature 1 To 16 Individual temperature of each selected
temperature spot element.

Observed Density Actual density of the product in the tank.

Reference Density Reference density as specified with the
configuration tool.

Flow rate Measured flow rate.

Tot Obs Volume Total observed product volume in the tank.

User defined 1 t 05 Custom measurement variable.

Middle Pressure Measured pressure from transmitter P2.

Tank Height Tank Reference Height

Alevel Difference between two product levels.

Select Variables in TankMaster WinSetup

Variables to present in the View Mode can also be configured by using the
TankMaster WinSetup configuration program. For more information see the
Raptor System Configuration Manual (Document no.300510EN).
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4.6.2 Select Tanks

Figure 4-15. The Select Tanks
menu

Figure 4-16. The Select Tanks
Custom option

4-10

In the Select Tanks menu, you can specify which tanks to show in View Mode.
The following items are available:

2410 Tank Position 1-10

The 2410 Tank Pos 1-10 menu lets you select which tanks to present in View
Mode. Up to ten tanks can be displayed. Note that the tanks need to be
configured in the tank database of the Rosemount 2410 Tank Hub(").

To select tanks:

All which displays all available tanks in View Mode

2410 Tank Pos 1-10 which lets you choose the tanks to present in
View Mode

1. In View Mode, press <Menu> <Options> <Select Tanks>:

Select tanks

©

Default
All

2410 Tank Pos 1-10

Esc | *+ | ¥

[ OK

2. Use the up and down arrow softkeys to navigate to the

2410 Tank Pos 1-10 menu item.

3. Press the <OK> softkey to continue to the list of tanks:

Select Tanks

)

M 01 Tank 1

2 02 Tank_2
M 03 Tank 3
[0 04 Tank 4

onlofif *+ [ ¥

[ OK

4. Use the up and down arrow softkeys to navigate to the desired tank.
5. Press the <On/Off> softkey to select the tank.
6. When finished, press the <OK> softkey to return to View Mode.

(1) See the Rosemount 2410 Tank Hub Reference Manual (Document no. 300530en)
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4.6.3 Units for Display

Figure 4-17. The Units for
Display menu

Figure 4-18. Select unit for
Length

In the Units for Display menu, you can see which measurement units that are
used for the displayed variables. The available measurement units are listed

in Table 4-2 on page 4-12.

To change measurement unit:

1. In View Mode, press <Menu> <Options> <Units for Display>:

Units for display @)
Length m
Level rate m/s
Flow rate m3/s
Volume m3
Esc | ¢ ¥ | =

2. Use the up and down arrow softkeys to navigate to the desired variable
menu item. In the example above, the Length variable was chosen.

3. Press the =) softkey to continue to the list of options for the selected

variable.

Length @
O Auto
® Millimeter
O Meter
O Feet _
Esc | 4 ¥ | OK

4. Use the up and down arrow softkeys to navigate to the desired

measurement unit.

5. Press the <OK> softkey to select the unit and return to the Units for

Display list.

See Table 4-2 for a list of available measurement units.

Section 4. Configuration and Operation



Reference Manual

300560EN, Rev AA
Rosemount 2230 May 2011

Table 4-2. Available

Rosemount 2230 , . .
Length The following units are available for Level and Ullage:
* Millimeter
* Meter
* Feet

* Imperial 1/16

Level rate The following units are available for Level rate:
» Meter/second
* Meter/hour
» Feet/second
» Feet/hour

Flow rate The following units are available for Flow rate:
» Cubic meter/hour
+ Barrel/hour
» US gallon/hour
* UK gallon/hour
+ Liter/minute

Volume The following units are available for Volume:
+ Cubic meter
+ Barrel
* US gallon
* UK gallon
* Liter

Temperature The following units are available for Temperature:
» Degrees Celsius
» Degrees Fahrenheit
* Kelvin

Pressure The following units are available for Pressure:
» Bar
+ Pascal
+ Kilo pascal
» Atmosphere
+ PSI
» Bar Absolute
» Bar Gauge
» PSI Absolute
+ PSI Gauge

Density The following units are available for Density:
+ Kilogram/Cubic m
* Kilogram/Liter
« Degrees API

Voltage Millivolt

4-12 Section 4. Configuration and Operation
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4.6.4 Toggle Time

Figure 4-19. Set Toggle time

4.6.5 Language

Figure 4-20. Set display
language

Section 4. Configuration and Operation

To set the Toggle Time:

The Toggle Time parameter specifies the time period that each value, or set of
values, is presented on the display.

1. From View Mode, press <Menu> <Options> <Toggle Time>:

Set Toggle Time

O

Toggle Time, s

3

Esc | ¢+ | ¥ |

OK

To set the display Language:

2. Use the up and down arrow softkeys to increase or decrease the Toggle

3. Press the <OK>softkey to select the desired value and return to View

1. Use the up and down arrow softkeys and navigate to the preferred
language option:

Select Language @ @
English _
Spanish
French
Italian _

Esc | ¢ | ¥ | OK

2. Press the <OK> softkey to select the language and return to View Mode.

4-13
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4.7 THE SERVICE
MENU

Figure 4-21. Service option in
the Main menu

Figure 4-22. The Service menu

4-14

In the Service Menu, the following items are available:

Status

Custody Transfer View
LCD Test

LCD Contrast

Restart

Factory Settings
About

To choose a Service menu item:

1.

2.
3.

4.

5.

In View Mode, press the <Menu> button to open the Main menu:

Main Menu ©
Select View
Options »
Service »
Esc | ¢+ [ ¥ [ =»

Use the 4 and § softkeys to navigate to the Service option.
Press the =) softkey.

Service Menu ©

Status...

Custody Transfer View
LCD Test

LCD Contrast...

Esc [ + | ¥ [ =

Use the up and down arrow softkeys to navigate to the desired menu
item.

Press the =p softkey to continue to the selected menu.

Section 4. Configuration and Operation
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471 Status

Figure 4-23. Rosemount 2230
status

4.7.2 Custody Transfer
View

Figure 4-24. Custody Transfer
view

The Status screen shows the current status of the 2230. Various error
messages and warnings can be displayed in case of software or hardware
malfunctions. See “Troubleshooting” on page 5-7 for more information.

To view the current status information:

1. In the View Mode, press <Menu> <Service> <Status>:

Status... D)
Network: OK
Hardware: GOOD
Write Protect: Off
Internal Temp: 25.3 °C
Esc [ * [ & ]

2. Press <Esc> to return to the Service menu.

See “Status Information” on page 5-2 for information on various status
messages.

The Custody Transfer view presents Level and Liquid Temperature for each
tank.

To open the Custody Transfer view:

1. In View Mode, press <Menu> <Service> <Custody Transfer>:

Tank 9 D)

Level
8161.0 mm

Liquid temperature
26.86 °C

Esc |Pause] ¥ |

2. Press the <Esc> softkey to return to View Mode.
3. Press the <Pause> softkey to pause the display toggling.
4. Press the down arrow § softkey to display the next tank.
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4.7.3 LCD Test

Figure 4-25. LCD test

4.7.4 LCD Contrast

Figure 4-26. The LCD Contrast
option

4-16

In the LCD test two checkered patterns will be displayed testing the whole
display area.

To open the LCD Test view:

1. In View Mode, press <Menu><Service><LCD Test>:

2. After the test is completed, the display will return to normal View Mode.

To adjust the LCD contrast:

1. In View Mode, press <Menu><Service><LCD Contrast>:

Adjust LCD Contrast (O
Contrast Adjustment

2

Esc | ¢ [ ¥ | OK

2. Use the up and down arrow softkeys to increase or decrease the LCD
contrast.

3. Press the <OK>softkey to select the desired value and return to View
Mode

Section 4. Configuration and Operation
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4.7.5 Restart

Figure 4-27. The Restart option

4.7.6 Factory Settings

Figure 4-28. The Restart option

Figure 4-29. Factory Settings

Section 4. Configuration and Operation

To restart the 2230:

1. In View Mode, press <Menu><Service>:

Service Menu S)
Custody Transfer View
LCD Test
LCD Contrast...
Restart _

Esc 4+ ¥ =»

2. Choose the Restart option and press the = softkey.
The Restart option will connect the Rosemount 2230 Graphical Field
Display to the Rosemount 2410 Tank Hub and perform start-up tests of
software and hardware.

To restore the 2230 to factory settings:

1. In View Mode, press <Menu><Service>:

Service Menu )
LCD Test
LCD Contrast...
Restart
Factory Settings...
|_Esc 1 ¥ |

2. Choose the Factory Settings option and press the =p softkey.

Factory Settings... O

Reset to factory settings
overwrites configuration
parameters. Are you sure?
Press Esc to cancel.

Esc | | [ OK

3. Press the <OK> softkey to restore the 2230 to factory settings, or press
the <Esc> softkey to cancel.

4. When the Rosemount 2230 is restored to factory settings, all user
configuration will be lost.
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4.7.7 About To view the About information:

1. In View Mode, press <Menu><Service>.
2. Choose the About option and press the = softkey.

Figure 4-30. Software revisions
for Rosemount 2230 About... o

Software Version: 1.A1
Serial N0.:123456789

Esc | | |

3. The About option will present the current software version and the 2230
serial number.

4. Press the <Esc> softkey to return to the Service menu.
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Section 5

5.1 SAFETY
MESSAGES

ROSEMOUNT

Tank Gauging

Service and Troubleshooting

51 SafetyMessages...............coviiinnnt. page 5-1
5.2 Service ........oiiiiiiiiiii it page 5-2
5.3 Troubleshooting ................. ..ot page 5-7

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A ). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

Explosions could result in death or serious injury:

Verify that the operating environment of the display is consistent with the appropriate
hazardous locations certifications.

Before connecting a FF-based communicator in an explosive atmosphere, make sure
the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

EMERSON.

www.rosemount-tg.com
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5.2 SERVICE

5.2.1 Status The Status screen lets you view the current status of the Rosemount 2230. To
Information open the status information screen:

1. In the View Mode, press <Menu> <Service> <Status>:

Figure 5-1. Rosemount 2230

status Status... ©
Network: OK
Hardware: GOOD
Write Protect: Off
Internal Temp: 25.3 °C
Esc | *+ [ ¥ ]

2. Use the 4 and § softkeys to view the various status messages.
3. Press <Esc> to return to the Service menu.

Various Status messages that appear on the 2230 display are listed in
Table 5-1:

Table 5-1. Status Information

Status Message

Network

Hardware

Write Protect

Internal Temperature
Maximum Temperature
Minimum Temperature
Operation time

Last restart
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5.2.2 Viewing Input
and Holding
Registers

Measured data is continuously stored in the Rosemount 2230 Input
Registers. They can be used for verifying that the Rosemount 2230 works
properly and for advanced troubleshooting.

The Holding Registers store various configuration parameters which are
used to control the display presentation.

By using the TankMaster WinSetup configuration tool most holding registers
can be edited by simply typing a new value in the appropriate value input field.

To view Input and Holding registers for the 2230 display, do the following:
1. Start the TankMaster WinSetup program

E% Metwork Connections
E| This Waorkstation
[—]a Tanks
555 All Tanks
- (30 k53
TK-54
TK-59

=

=B Fcuzm
=-100 HUB-101
g LT-50
o ’ Uninstall
-] Fixed Roof
-] Devices Save Database to File...

-] Protocols Upload Database...
View Input Registers...

View Holding Registers...

View Diagnostic Registers...
Restart...
Loegging...

Write Protect

Properties

2. In the TankMaster WinSetup workspace window, click the right mouse
button on the ATD device icon. The ATD device represents all the
non-level devices such as the 2230 display.

3. Choose the View Input Registers (or View Holding Registers) option, or
from the Service menu choose Devices > View Input / View Holding
Registers.
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(31 View Input Registers - ATD-TK-1 L_J&
Search for Show Values in
= + Dec
. " Hex
Start Register: Mumber of Registers:
Fi2230_1_Status DeviceStatus ~| [m@
Mame Fegister Unit =
F2230_1_Status-DeviceStatus 16100
F2230 1_Status-DeviceE mor 16102
F2230 1_Status-Device's aming 16104
F2230 1_Status-Internal_Temp 16106 C
F2230 1_Status-IntT empStatus 16108 1]
R2230_1_5tatus-MinlntT emp 16110 -30 C
R2230_1_Status-MaxintT emp 16112 E9.75 C
R2230_1_5tatus-HeartbeatCount 16114 593165
R2230_1_HostComlinfo-MrofRequests 16500 93593 #
R2230_1_HostComlinfo-MrofDKResp 16502 93593 # j
Bead Cloze Help |
. The Predefined option lists a basic selection of useful registers.
. Choose the desired Start Register and enter the Number of Registers
to read.
. Click the Read button to update the Value column with the current
register values.

5-4
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5.2.3 Restarting the To restart the Rosemount 2230 choose one of the following options:
2230 Display » choose the Restart option in the Service menu, see “Restart” on
page 4-17

+ press the Reset button inside the display cover, see Figure 5-2

» use the Restart command in TankMaster WinSetup (Right
click>Restart)

The Restart option will connect the Rosemount 2230 Graphical Field Display
to the Rosemount 2410 Tank Hub and perform start-up tests of software and
hardware.

.

Ao

e
JoN
Reset button T

Figure 5-2. Reset button

TORIT—7~6)
E N 77~

NOTE!

Ensure that o-rings and seats are in good condition prior to mounting the
cover in order to maintain the specified level of ingress protection. Cables
must be properly attached to the cable glands.
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5.2.4 Device Error
Signals

Figure 5-3. Error signals

Table 5-2. Status LED error
codes

5-6

A Light Emitting Diode (LED) inside the 2230 cover is used for presentation of
device status using different blinking sequences.

Status LED

_f, 7 )

In normal operation the LED flashes once every other second. When an error
occurs, a sequence of LED flashes presents a code number followed by a
four second pause. The flash sequence is continuously repeated.

The following error codes can be presented by the LED:

LED Status Code Error Type

0 RAM error

FPROM error

HREG error

SW error

Other memory error
Internal temperature error
Measurement error

© B~ WON =

=N
N

See “Device Errors” on page 5-9 for more information about the different error
messages.

Example

Error code 3 is displayed as the following flash sequence:

| | | | | |
0 5 10 15 20 30 Time (seconds)

NOTE!
Only the first detected error is indicated.

NOTE!

Ensure that o-rings and seats are in good condition prior to mounting the
cover in order to maintain the specified level of ingress protection. Cables
must be properly attached to the cable glands.

Section 5. Service and Troubleshooting
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5.3 TROUBLESHOOTING Table 5-3 provides summarized maintenance and troubleshooting
suggestions for the most common operating problems.

Table 5-3. Troubleshooting
chart for the 2230 display

Symptom Possible cause Action
No communication with the Wiring « Check that wires are properly connected to the
Rosemount 2230 terminals

» Check for dirty or defective terminals

» Check wire insulation for possible short circuits to
ground

» Check that there are no multiple shield grounding points

» Check that the cable shield is grounded at the power
supply end (2410 Tank Hub) only

» Check that the cable shield is continuous throughout
the Tankbus network

» Check that the shield inside the instrument housing

does not come into contact with the housing

Check that there is no water in conduits

Use shielded twisted pair wiring

» Connect wiring with drip loops

Check the 2410 Tank Hub wiring

Incorrect Tankbus termination « Check that there are two terminators on the Tankbus.
Normally the built-in termination in the 2410 Tank Hub is
enabled.

» Check that terminations are placed at both ends of the
Tankbus

Too many devices on the Tankbus

Check that the total current consumption of the devices
on the Tankbus is less than 250 mA. See the
Rosemount 2410 Reference Manual (Document no.
305030en) for more information.

* Remove one or more devices from the Tankbus. The
2410 Tank Hub supports a single tank. The multiple
tank version of the 2410 supports up to 10 tanks.

Cables are too long + Check that the input voltage on the device terminals is
9 V or more
Hardware failure » Check the 2230

» Check the 2160 Field Communication unit (FCU)

» Check the Field Bus Modem

» Check the communication port on the control room PC

» Contact Emerson Process Management/Rosemount
TankGauging service department

Software failure

Restart the 2230. Use for example the Restart
command in TankMaster WinSetup.

Restart all devices by disconnecting and connecting the
power supply to the 2410 Tank Hub

» Contact Emerson Process Management/Rosemount
TankGauging service department

Field Bus Modem (FBM)

Check that the FBM is connected to the right port on the
control room PC

Check that the FBM is connected to the right port on the
2160 Field Communication Unit (FCU)

Connection to 2160 FCU « Check that the right field bus port on the 2160 FCU is
connected to the Primary bus on the 2410 Tank Hub

* Check communication port LED:s inside the Field
Communication Unit 2160 (FCU)
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Symptom

Possible cause

Incorrect configuration of 2160 Field
Communication Unit (FCU)

Action

» Check the Modbus communication address specified
for the ATD device that represents the 2230 display in
the 2160 FCU Slave Database. For the single tank
version, the ATD address is equal to the Modbus
address of the 2410 Tank Hub itself.

Check configuration of communication parameters for
the FCU Fieldbus ports

Check that the correct communication channel is
selected

See the Raptor System Configuration Manual
(Document no. 300510EN) for more information on how
to configure the 2160 FCU

Incorrect configuration of tank database in
2410 Tank Hub

» Check the 2410 tank database; ensure that the 2230

device is available and mapped to the right tank

2410 Tank Database; check that the ATD Modbus

address is equal to the 2470 Temp Modbus address in

the FCU Slave Database

« See the Raptor System Configuration Manual
(Document no. 300510EN) for more information on how
to configure the 2410 tank database

Connection to 2410 Tank Hub

» Check wiring to the 2410 Tank Hub
« Check the 2410 Tank Hub; check the Error LED or the
integral display for information

Configuration of communication protocol

In TankMaster WinSetup:
+ open the Protocols folder and check that the protocol
channel is enabled
« check the protocol channel configuration (right-click
the protocol channel MbMaster icon, choose the
Properties option, and check port, parameters,
modem)

The Status LED is blinking error
codes

» Hardware errors
» Software errors

« See “Device Error Signals” on page 5-6

» Check Device Status information. See “Status
Information” on page 5-2 and “Viewing Input and
Holding Registers” on page 5-3)

» See “Device Errors” on page 5-9

Configuration can not be saved

Write protection switch is set to the ON
position

Check write protection switch on the 2230.

Invalid measurement data (--.---)

Device failure

Check the devices connected to the Tankbus for possible
hardware or software failure

Warning symbol appears in front
of measurement value

Simulation mode active

Stop simulation mode in WinSetup (open WinSetup Set
Simulation Mode window and click the Stop button)

Activity indicator shows a warning
symbol

Communication failure

Check that the 2230 is configured in the 2410 tank
database. See the Raptor System Configuration Manual
(Document no. 300510EN) for more information on how to
configure the 2410 tank database.

Nothing appears on the LCD
display

* No power supply
» FISCO fuse broken
+ Contrast settings

Check status LED (see “Device Error Signals” on
page 5-6).
If Status LED does not light:
» check power on Tankbus wiring
+ check FISCO fuse
If Status LED lights:
« check contrast settings of the LCD display

5-8
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5.3.1 Device Errors Table 5-4 shows a list of error messages for the Rosemount 2230. Detailed
information about the different error types can be found in Input registers 1100
- 1134 as shown in Table 5-4.

Table 5-4. Device Errors

Message

RAM Error

Description

Input register no. 1100(".

The following bits indicate a serious
RAM problem.

Bit 0: RAM

FPROM Error

Input register no. 1102.

The following bits indicate a serious
FPROM problem or wrong software
versions loaded.

Bit 0: Checksum Error

Bit 4: Boot Checksum

Bit 5: Boot Version (Invalid version
number)

Bit 6: Application Checksum

Bit 7: Application Version (Invalid
version number)

Hreg Error

Input register no. 1104.

The following bits indicate a serious
Holding register problem. NOTE: the
Holding register default values are
used in case of an error.

Bit 0: Checksum Error

Bit 1: Limit Error. One or more
Holding register is out of range.

Bit 2: Version Error. Invalid SW
version detected.

Bit 3: HREG Read Error.

Bit 4: HREG Write Error. Failed to
program a cell in the EEPROM.

SW Error

Input register no. 1106.

Bit 0: Undefined SW error.
Bit 1: Task not running

Bit 2: Out of stack space

Bit 3: Unused RAM access.
Bit 4: Divide by zero error
Bit 5: Reset counter overflow
Bit 15: Simulated SW error

Other Memory Error

Input register no. 1108.
Bit 0: NVRAM_Access

Action

Contact Emerson Process
Management/Rosemount TankGauging
service department.

Display Error

Input register no. 1112.

Not used

Modem Error

Input register no. 1114.

Not used

Internal Temperature Error

Input register no. 1118.

Bit O: Internal temperature out of
range

Bit 1: Communication error with temp
chip

Bit 2: Device error

Contact Emerson Process
Management/Rosemount TankGauging
service department.

Measurement Error

Input register no. 1122.

Not used

Section 5. Service and Troubleshooting
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Message Description Action

Configuration Error Input register no. 1124.

Bit 1: Unit Not Supported Choose a supported measurement unit

numHiddenErrors Input register no. 1132.

Number of hidden errors. Contact Emerson Process

Management/Rosemount TankGauging
numOtherErrors Input register no. 1134. service department.

Number of other errors.

(1) The register number refers to the internal Input Register of the 2230 database.
Note that Input Register data from the 2230 display is temporarily stored in the Input Register database of the 2410 Tank Hub. The Input
Registers presented in TankMaster WinSetup refer to the internal register area of the 2410. Therefore, for tank 1 you will have to add 16000
to the 2230 internal register number as given by Table 5-4 in order to find the register presented by WinSetup. For the second and third
2230 display you will have to add 18000 and 20000, respectively.

5.3.2 Device Warnings Device warnings are signaled in the Input Register Device Warnings.
Warnings are less serious than errors. Detailed information about the different
warning types can be found in Input registers 1050 - 1070.

Table 5-5. Device warnings

Message Description Action

RAM warning Input register no. 1050, Contact Emerson Process
The application software could not be | Management/Rosemount TankGauging
started. service department.
Bit 0: Stack low

FPROM warning Input register no. 1052 Not used

Hreg warning Input register no. 1054. Contact Emerson Process
Bit 0: Default Holding register values | Management/Rosemount TankGauging
used service department.

Other memory warning Input register no. 1056 Not used

Display warning Input register no. 1058 Not used

Modem warning Input register no. 1060 Not used

Other hardware warning Input register no. 1062 Not used

Measurement warning Input register no. 1064 Not used

ITEMP warning Input register no. 1066.
Bit 0: The internal temperature is out
of range

Software warning In.put. register no. 1068. Contact Emerson Process
Bit 1: Stack low (less then 10% left of .
stack) Manggement/Rosemount TankGauging
Bit 2: Software startup service department.

Configuration warning Input register no. 1070
Bit 11: Invalid Model Code String
Bit 12: Invalid Model Code

(1) The register number refers to the internal Input Register of the 2230 database. The Input Registers presented in TankMaster WinSetup
refer to the internal register area of the 2410. For tank 1 add 16000 to the 2230 internal register number as given by Table 5-5 in order to
find the register presented by WinSetup. For the second and third 2230 display you will have to add 18000 and 20000, respectively.
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5.3.3 Status Status information is available for each measurement variable via the Status
Information button in the View menu.

Tank-5 )

Level

2412 m

Liquid temperature
26.7 °C

Menu [Pause] ¥ [Status

Status button

Table 5-6. Status Information

Status Description

Invalid_TV_Value Invalid source value.

InvalidSourceConfig The source value (Tank Variable) is invalid
due to one of the following reasons:
« Incorrect configuration
 Out of service in FF
« Incorrect configuration of measurement
units

DataFrozen Tank measurement variable not updated for a
configurable time or the source data is frozen.

Saturated Low Tank measurement variables is outside lower
range or saturated.

Saturated High Tank measurement variables is outside upper
range or saturated.

Simulated The tank measurement variable is simulated.

Manual Value The tank measurement variable value is

manual (constant).

Approved Value The tank measurement variable value is inside
approval range and the device is write
protected.

Invalid Value The tank measurement variable value is
invalid.
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Appendix A Reference Data

A1 Specifications .......... ... i, page A-1

A.2 Dimensionaldrawings ...............0cvvuunn page A-3

A.3 Ordering Information ........................ page A-4

A.1 SPECIFICATIONS

Product

Toggle time

Language selection possibilities
Variables to display

Units to display

Hazardous location certifications and IS
parameters

CE-mark
Ordinary location certification

Power supply

IS parameters

Bus current draw

Display type

Start-up time

Update rate

Response time

Cable entry" (connection/glands)

Tankbus cabling
Built-in termination

Housing material
Dimensions (width x height x depth)
Weight

Rosemount 2230 Graphical Field Display
The time each value or set of values are shown on the display: 2-30 s
English, French, German, Spanish, Italian, and Portuguese

Level, level rate, ullage, signal strength, volume (TOV), liquid average temperature,
1-16 spot temperature, vapor average temperature, ambient temperature, free water
level, vapor pressure, liquid pressure, air pressure, observed density, and flow rate
Level, free water level, and ullage: meter, millimeter, feet, or imperial 1/16

Level rate: meter/second, meter/hour, feet/second, or feet/hour

Flow rate: meter®/hour, liter/minute, feet’hour, barrel/hour, or US gallon/hour

Total Observed Volume (TOV): meter?, liters, feet®, barrel, or US gallon
Temperature: °F, °C, or °K.

Pressure: psi, psiA, psiG, bar, barA, barG, atm, Pa, or kPa

Density: kg/m?®, kgl/liter, or °API

Signal strength: mV

ATEX, FM-C, FM-US, and IECEx.

Complies with applicable EU directives (EMC, ATEX)
Complies with FM 3810:2005 and CSA: C22.2 No. 1010.1

Powered by Rosemount 2410 Tank Hub (9.0-17.5 VDC, polarity insensitive)
See “Product Certifications” on page B-1

30 mA

Back-lit LCD monochrome display. 128x64

5s

New values to display once every two seconds

< 0.5 s from released button to new image

Three entries, two M20x1.5 and one M25x1.5.

Optional:

* % - 14 NPT conduit / cable adapter

* Metal cable glands (%2 - 14 NPT)

* 4-pin male Eurofast connector or A size Mini 4-pin male Minifast connector

AWG 0.5-1.5 mm? (22-16), shielded twisted pairs
Yes (to be connected if required)

Polyurethane-covered die-cast aluminum
150 x 120 x 78 mm (5.9 x 4.7 x 3.1 in.)
1.2 kg (2.6 Ibs)

I
i~
~
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Environment

Ambient temperature -20 to 70 °C (-4 to 158 °F)

Storage temperature -30 to 85 °C (-22 to 185 °F)

Humidity 0-100% relative humidity, non-condensing
Ingress protection IP 66 and 67 (Nema 4)

Metrology sealing possibility Yes

Write protect switch Yes

(1) Make sure that unused ports are properly sealed to prevent moisture or other contamination from entering the electronics housing. Use the enclosed metal
plug for this purpose.
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A.2 DIMENSIONAL
DRAWINGS

Figure A-1. Dimensional
drawings

Appendix A. Reference Data

78 mm (3.1in.)

T

150 mm (5.9 in.)

120 mm (4.7 in.)
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A.3 ORDERING

INFORMATION

Model (Pos 1) Product Description Note

Code (Pos 2) Default Language Note

Code (Pos 3) Tankbus: Power and Communication Note

Code (Pos 4) Software Note

Code (Pos 5) Hazardous Location Certification Note

| ATEX Intrinsic Safety

15 FM-US Intrinsic Safety

16 FM-Canada Intrinsic Safety

17 IECEX Intrinsic Safety

KA ATEX Intrinsic Safety+FM-US Intrinsic Safety(")

KC ATEX Intrinsic Safety+IECEX Intrinsic Safety(")

KD FM-US Intrinsic Safety+FM-Canada Intrinsic Safety(")

NA No Hazardous Location Certification

Code (Pos 6) Custody Transfer Type Approval Note

R OIML R85 E performance certification

0 None

Code (Pos 7) Housing Note

Code (Pos 8) Cable/Conduit Connections Note

1/2—14 NPT and 3/4-14 NPT Adapters Female thread. Includes 2 plugs and 3 adapters
2 M20 x 1.5 and M25 x 1.5 Female thread. Includes 2 plugs
Metal Cable Glands (M20 x 1.5 and M25 x 1.5) Min. temperature -20°C (-4°F). ATEX / IECEx
Exe approved. Includes 2 plugs

E Eurofast Male, M20 x 1.5 and M25 x 1.5 3 plugs included

M Minifast Male, M20 x 1.5 and M25 x 1.5 3 plugs included

Code (Pos 9) Mechanical Installation Note

Wall installation kit included

Code Options — none or multiple selections are possible Note

Engraved SST tag plate Provide tag information in order

Model Code Example: 2230-EFSIM0A1W-ST

(1) Not available with LPG/LNG antenna.
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B.1 Safetymessages ................ ... i, page B-1

B.2 EUConformity ................ ..o, page B-2

B.3 Hazardous Locations Certifications ............ page B-3

B.4 ApprovalDrawings ................ciiiiinnnn page B-8
B.1 SAFETY Procedures and instructions in this section may require special precautions to
MESSAGES ensure the safety of the personnel performing the operations. Information that

raises potential safety issues is indicated by a warning symbol (A ). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

Explosions could result in death or serious injury:

Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make
sure the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the transmitter cover in explosive atmospheres when the circuit is alive.

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure the transmitter is installed by qualified personnel and in accordance with
applicable code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

Any substitution of non-recognized spare parts may jeopardize safety. Repair, for e.g.
substitution of components etc. may also jeopardize safety and is under no
circumstances allowed.

To prevent ignition of flammable or combustible atmospheres, disconnect power before
servicing.

ROSEMOUNT s
Tank Gauging EMERSON.
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B.2 EU CONFORMITY

B-2

High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals.

Make sure the mains power to the Radar Transmitter is off and the lines to any other
external power source are disconnected or not powered while wiring
the transmitter.

Probes covered with plastic and/or with plastic discs may generate an ignition-capable
level of electrostatic charge under certain extreme conditions. Therefore, when the
probe is used in a potentially explosive atmosphere, appropriate measures must be
taken to prevent electrostatic discharge.

The EC declaration of conformity for all applicable European directives for this
product can be found on the Rosemount Tank Gauging web site at
www.rosemount-tg.com. A hard copy may be obtained by contacting our local
sales representative.

Appendix B. Product Certifications



Reference Manual
300560EN, Rev AA
May 2011

Rosemount 2230

B.3 HAZARDOUS
LOCATIONS
CERTIFICATIONS

B.3.1 Factory Mutual
US Approvals

Figure B-1. Factory Mutual
Intrinsic Safety US Approval
Label

2230-

Appendix B. Product Certifications

2230 GRAPHICAL FIELD DISPLAY

OF COMPO-
QNING: SUBSTITUTION
MFG ( yymmdd); FISCO FIELD DEVICE AND ENTITY % ‘;"ﬁ;‘ms MAY IMPAIR INTRINSIC SAFETY
SIN: . _ IS Class |, Il Il Div. 1 Grp ABCDEFG Entity/FISCO . JARNING: POTENTIAL
N: ”Fﬁ%;%mgﬁfm TEMP. CODE T4 AMB. TEMP. LIMITS -50°C T0 70°C PLACE FOR NON-#M INFoRMATION: \é\&%gROSTAﬂC CHARGING HAZARD
) Class | ZONE 0 AEx ia IIC Entlty/FISCO TIONS
PLACE FOR NON-FM ENTITY: Ui=30V, li=300mA, Pi=1.3W, Ci=2.1nF, SEE INSTRUC
INFORMATION* Li=t.1pH ’
INSTALL PER CONTROL DRAWING 5240040-949
ENCL. TvPE 4, e oy HONA,S. SUPPLY SEE INSTALLATION INSTRUGTION DOCUMENT Tank Gauging

=== 832 \DC 30mA

The Rosemount 2230 Graphical Field Displays that have the following labels
attached have been certified to comply with the requirements of the approval
agencies noted.

Certificate of Compliance: 3037177

MADE IN GOTHENBURG SWEDEN

CAUTION: KEEP COVER GUARD CLOSED

15

FISCO Field Device (Fieldbus Terminals)

Intrinsically Safe for Class I, Il, Ill Division 1, Groups A, B, C, D, E, Fand G
Temperature Class T4, Ambient Temperature Limits: -50 °C to +70 °C
Class | Zone 0 AEx ia lIC T4 (-50 °C < Ta < +70 °C)

Ui=17.5V, li=380mA, Pi=5.32W, Ci=2.1nF, Li=1.1uyH

Entity (Fieldbus Terminals)

Intrinsically Safe for Class I, Il, Ill Division 1, Groups A, B, C, D, E, Fand G
Temperature Class T4, Ambient Temperature Limits: -50 °C to +70 °C
Class | Zone 0 AEx ia lIC T4 (-50 °C < Ta < +70 °C)

Ui=30V, 1i=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1pyH

Install per Control Drawing 9240040-949

Special Conditions of Use

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore
particularly when it is used for applications that specifically require Division 1
and Group Il, Zone 0 located equipment, the equipment shall not be installed
in a location where the external conditions are conducive to the build-up of
electrostatic charge on such surfaces. Additionally, the equipment shall only
be cleaned with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential
risk of ignition by impact or friction. Care must be taken during installation and
use to prevent impact or friction.

3. The associated apparatus through which the equipment is supplied shall
provide galvanic isolation between the input and output of the associated
apparatus.
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B.3.2 Factory Mutual
Canadian Approvals

Figure B-2. Factory Mutual
Intrinsic Safety Canadian
Approval Label

2230-

MFG (yymmaa);
SIN;

"PLACE FOR NON-1

INFORMATION"

ENCL. TYPE 4%, Ipgs, Ipg7

B-4

2230 GRAPHICAL FIELD DISPLAY

"PLACE FOR NON.Fy

OF COMPO-
O RNING: SUBSTITUTION
FISCO FIELD DEVICE AND ENTITY AePROVED ‘S:NTS MAY MPAR NTRISIC SAFETY
IS Class |, I Il Div. 1 Grp ABCDEFG EnitylFISCO . WARNNG POTENTAL
°E FOR NN TEMP. CODE T4 AMB, TEMP. LIMITS -50°C TO 70°C "PLACE FOR NON-#M INFORMATION- TATIC CHARGIN
INFORMATION Class | ZONE 0 AEx ia IIC Entlty/FISCO RN R

NOMA,S. SUPPLY: SEE INSTALLATION INSTRUCTION DOCUMENT
=== 532 VDC 30ma

Certificate of Compliance: 3037177C.

RG SWEDEN

MADE 1N GOTHENBUI

TIONS
ENTITY: Ui=30V, li=300mA, Pi=1.3W, Ci=2.1nF, SEE INSTRUC

Li=t.1pH .
INSTALL PER CONTROL DRAWING 9240040-942 .
Tank Gauging
CAUTION: KEEP COVER GUARD CLOSED

16

FISCO Field Device (Fieldbus Terminals)

Intrinsically Safe for Class |, Il, Il Division 1, Groups A, B, C, D, E, Fand G
Temperature Class T4, Ambient Temperature Limits: -50 °C to +70 °C
Ui=17.5V, 1i=380mA, Pi=5.32W, Ci=2.1nF, Li=1.1uH

Entity (Fieldbus Terminals)

Intrinsically Safe for Class |, Il, Il Division 1, Groups A, B, C, D, E, Fand G
Temperature Class T4, Ambient Temperature Limits: -50 °C to +70 °C
Ui=30V, 1i=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1yH

Install per Control Drawing 9240040-949

Special Conditions of Use

1. The associated apparatus through which the equipment is supplied shall

provide galvanic isolation between the input and output of the associated
apparatus.
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B.3.3 European ATEX The Rosemount 2230 Graphical Field Displays that have the following labels
Directive Information attached have been certified to comply with Directive 94/9/EC of the

European Parliament and the Council as published in the Official Journal of
the European Communities No. L 100/1 on 19-April-1994.

Figure B-3. ATEX Intrinsic
Safety Approval Label

2230 GRAPHICAL FIELD DISPLAY TTADE N GOTHENBURG SWEDEN

2230- C€osms po-
' TION OF COM
MFG (yymmdd): FISCO FIELD DEVICE FISCO FIELD DEVICE WARNING: su&s;lgl"mﬂm SIG SAFETY
Yymmdd): ExialiC Ga T4 (-50°C<Ta<70°C) & 111G ExialiC T4 (-50°C<Ta<70°C) NENTS MAY |
SIN: PLACEFOR NoN g | oitiss s st Mbasssansassesesssssisesinsensaniey ARNING: POTENTIAL
: WFEO;?”& ;mnﬁm ENTITY ENTITY WLECTROSTATIC CHARGING HAZARD
ION ExiallC Ga T4 (-50°C<Ta<70°C) 1116 Ex ia IC T4 (-50°C<Ta<70°C) =

"PLACE FOR NON-£M SEE INSTRUCTIONS

INFORMATION: Ui=30V, i=300mA, Pi=1.3W, Ci=2.4nF, Li={.AuH  Ui=30V, i=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1uH

........................................................................
IECEx FMG 10.0021X FM10ATEX0046X

NONLS, SUPPLY: INSTALL PER CONTROL DRAWING 9240040049
== 3-32V0C 30mA SEE INSTALLATION INSTRUCTION DOCUMENT

ENCL TYRE 4x.[pes, ooy Tank Gauging

11 The following information is provided as part of the label of the
transmitter:

+ Name and address of the manufacturer (Rosemount)
CE Conformity Marking

c € 0575

¢ Model number

« Serial number of the device

* Year of construction

+ ATEX EC-Type Examination Certificate Number FM10ATEX0046X
 Install per Control Drawing: 9240040-949

FISCO Field Device (Fieldbus Terminals)

&na

+ ExiallC T4 (-50 °C < Ta < +70 °C)
. Ui=17.5V, li=380mA, Pi=5.32W, Ci=2.1nF, Li=1.1uH

Entity (Fieldbus Terminals)

Enia

+ ExiallC T4 (-50 °C < Ta< +70 °C)
+ Ui=30V, 1i=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1pyH

Appendix B. Product Certifications B-5
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Specific Conditions of Certification (X)

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore
particularly when it is used for applications that specifically require Group Il,
Zone 0 located equipment, the equipment shall not be installed in a location
where the external conditions are conducive to the build-up of electrostatic
charge on such surfaces. Additionally, the equipment shall only be cleaned
with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential
risk of ignition by impact or friction. Care must be taken during installation and
use to prevent impact or friction.

3. The associated apparatus through which the equipment is supplied shall
provide galvanic isolation between the input and output of the associated
apparatus.
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B.3.4 |IECEx Approval

Figure B-4. IECEX Intrinsic
Safety Approval Label

2230-

MFG (yymmad):
SIN;

"PLACE FOR NON-#M

INFORMATION®

ENCL. TYPE 4X, [ps, Ipp7

Appendix B. Product Certifications

2230 GRAPHICAL FIELD DISPLAY

"PLACE FOR NON-FM
INFORMATION®

NON-1S. SUPPLY.
===8.32VDC 30mA

TIADE T GOTHENBURG SWEDEN
0575 N OF COMPO-
FISCO FIELD DEVICE FISCO FIELD DEVICE c € WARNING: SL’&F?;‘L;L,’J‘T%WC SAFETY
ExialIC Ga T4 (-50°C<Ta<70°C) & 1116 Exia IIC T4 (-50°C<Ta<70°C) NENTS &g\vplmENTl N
........................................................................ RNING:
ENTITY ENTITY VE“SECTROSTATIG GHARGING HAZARD

ExialIC Ga T4 (-50°C<Ta<70°C)
Ui=30V, 1i=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1pH
IECEX FMG 10.0021X FM10ATEX0046X

INSTALL PER CONTROL DRAWING 9240040-949
SEE INSTALLATION INSTRUCTION DOCUMENT

& N1GExialiCT4 (-50°C<Ta<70°C)
Ui=30V, li=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1pH

SEE IN STRUCTIONS

Tank Gauging

I7  The following information is provided as part of the label of the
transmitter:

* Name and address of the manufacturer (Rosemount)

* Model number

» Serial number of the device

» |ECEX Certificate of Conformity Number IECEx FMG 10.0021X
* Install per Control Drawing: 9240040-949

FISCO Field Device (Fieldbus Terminals)
+ ExiallC GaT4 (-50 °C £ Ta< +70 °C)
+ Ui=17.5V, 1i=380mA, Pi=5.32W, Ci=2.1nF, Li=1.1uH

Entity (Fieldbus Terminals)
+ ExiallC GaT4 (-50 °C < Ta< +70 °C)
« Ui=30V, li=300mA, Pi=1.3W, Ci=2.1nF, Li=1.1uH

Specific Conditions of Certification (X)

1. The non-metallic parts incorporated in the enclosure of this equipment may
generate an ignition-capable level of electrostatic charge. Therefore
particularly when it is used for applications that specifically require Group Il,
Zone 0 located equipment, the equipment shall not be installed in a location
where the external conditions are conducive to the build-up of electrostatic
charge on such surfaces. Additionally, the equipment shall only be cleaned
with a damp cloth.

2. The enclosure contains aluminum and is considered to present a potential
risk of ignition by impact or friction. Care must be taken during installation and
use to prevent impact or friction.

3. The associated apparatus through which the equipment is supplied shall
provide galvanic isolation between the input and output of the associated
apparatus.
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B.4 APPROVAL Follow the installation guidelines presented in Factory Mutual system control
DRAWINGS drawings in order to maintain certified ratings for installed devices.

The following drawings are included in the documentation for the Rosemount
2230 Graphical Field Display:

9240040-949 System Control Drawing for hazardous location installation of
intrinsically safe FM approved apparatus.

See the “Manuals & Drawings” CD ROM that is shipped with the 2230
Graphical Field Display for electronic copies of the system control drawings.

Drawings are also available on the Rosemount Tank Gauging web site:
www.rosemount-tg.com.
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Rosemount and the Rosemount logotype are trademarks of Rosemount Inc.
HART is a trademark of the HART Communication Foundation.

PlantWeb is a trademark of one of the Emerson Process Management group of companies.

AMS Suite is a trademark of Emerson Process Management.
FOUNDATION is a trademark of the Fieldbus Foundation.

VITON, and Kalrez are trademarks of DuPont Performance Elastomers.
Hastelloy is a trademark of Haynes International.

Monel is a trademark of International Nickel Co.

All other marks are the property of their respective owners.

Emerson Process Management

Rosemount Tank Gauging

Box 130 45

SE-402 51 Goteborg

SWEDEN

Tel (International): +46 31 337 00 00
Fax (International): +46 31 25 30 22
E-mail: sales.rig@emerson.com
www.rosemount-tg.com

© 2011 Rosemount Tank Radar AB. All rights reserved.
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